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Dear Sir / Madam,  

 

Thank you for choosing GCC and the JV-240UV Varnish Printer. You can be assured that this 

machine meets the highest safety standards while using technological innovations shared by no 

other UV printer. JV-240UV Varnish Printer is backed by GCC, a truly international company that is 

dedicated to help your business grow.  

 

We at GCC are proud to introduce the JV-240UV Varnish Printer, our most technologically advanced 

UV printer to date. This easy to operate machine has been designed with quality, productivity, and 

safety in mind. With innovations and outstanding quality with high productivity, the JV-240UV is 

clearly on the cutting edge of all UV inkjet systems.  

GCC understands that a creative technical background is the key to successful growth in the 

ever-changing information economy. We have a strong team of R&D experts who propel our 

company to new heights. From product development to manufacturing, our engineers are 

dedicated to innovation and quality.  

 

Guiding our solid technical base is a world-class management team. At GCC, our leaders bring 

together marketing, technical support, research development and distribution experts to create an 

international network to meet your demands. Over the years, this network has been able to span 

throughout the globe. Our technical support staff is committed to provide you with impeccable 

service, and when your business is ready to grow, our team will be there!  

 

 

Sincerely,  

Leonard Shih  

President of G.C.C. 
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Release Note 

Version Change 

V.1 2017 Nov.  

V.2 2018 Dec. 

Add 6.8 How to replace alignment rule 

Add 5.1.1 Use the lamilator with decurling device to keep the sheet flat 

Add 5.1.6 How To Make Varnish Grayscale 
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Chapter 1 Introduction 

1.1 Warning 

These symbols are applied in the user manual for the safety precaution and to prevent equipment 

from damage. These symbols are informational notice. Please do understand meanings for each of 

these symbols and its related safety precautions prior operate the equipment. 

No. Safety label Graphic Content 

1 Warning 

 

The symbol indicates that fire is 

prohibited. The ink and the fluid 

discharged out are highly 

flammable. 

2 High Voltage 

 

The symbol indicates high 

voltage.  Remove the lid could 

lead to expose to high voltage or 

electric shock. 

3 Warning 

 

The symbol indicates that the ink 

is health hazardous.   

The ink and fluid discharged out 

is health hazardous, avoid body 

contact. 

4 Ink Leaking 

 

The symbol indicates to avoid the 

ink leaking.   

Turn off all valves of print heads 

before switching off the printer. 



                                           JV-240UV User Manual 

6 

 

5 Ground Wire 

 

The symbol indicates the 

machine should be grounded 

before conducting any 

maintenance or cleaning 

operation due to possible 

electrostatic discharge.   

6 Printing 

Warning 

 

The symbol indicates that during 

the printing process do not put 

your hands in the printing area to 

avoid injury. 

7 Avoid Injury 

Warning 

 

The symbol indicates that during 

the printing process do not put 

your hands in the area to avoid 

your hands being pinched by 

moving parts.  

8 Keep Clear 

Warning 

 

The symbol indicates that do not 

put objects in addition to print 

media on the print area at all 

times to prevent print head being 

crashed by obstacles.  

9 Do Not Push 

Warning 

 

The symbol indicates that do not 

push carriage axis while moving 

the machine.  

 

1.2 Inks Safety Information 

Health Effects of Exposure to Ink 

Contact by Effect 

Inhalation 
Can cause severe respiratory irritation, dizziness, weakness, fatigue, nausea, 

and headache. 
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Skin 
Can cause dermatitis or irritation that may last for hours or days, but unlikely 

to result in permanent harm. 

Eye 
Can cause severe irritation, tearing, and burns that may eventually lead to 

permanent impairment, including blindness. 

Swallow 
Can cause severe irritation to mouth, throat, and stomach, may further inflict 

abdominal discomfort, nausea, vomiting and diarrhea. 

 

Disposal Considerations 

Waste ink contains hazardous substances. Do not dispose waste ink with household rubbish. Do 

not allow product to reach sewage system. Recommend to dispose waste ink according to official 

regulations. 

 

1.3 First-Aid Measures 

Contact by Remedy 

Inhalation Breathe in fresh air and consult a doctor in case of complaints. 

Skin 
Immediately wash with soap and water then rinse thoroughly. If skin 

irritation continues, consult a doctor. 

Eye 

First and for most, flush your eyes with plenty of water. Then, tilt your head 

to prevent chemical from transferring to the uncontaminated eye. Finally, 

seek immediate medical attention and monitor the eye as advised by your 

physician. Inform your physician that your eye was exposed to chemical ink. 

Swallow 
Do not induce vomiting. Drink copious amount of water or milk to dilute 

and breathe in fresh air, then, seek medical attention immediately. 

 

 

1.4 Personal Protection 

Protection Solution 

Respiratory 

Protection 
Ventilation may be required depending upon conditions of use. 
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1.5 Ink Operating and Storage Environment 

Store the inks away from direct sunlight or other lighting sources, including fluorescent lighting. 

Store them away from acids, alkalis, and oxidizing material as well. Additionally, keep container 

tightly closed in a dry, cool, well ventilated place.  

The recommended ink storage temperature as following: 

* Temperature: 22°C to 30°C (71.6°F to 86°F). Humidity: 40% to 60%. 

* Please do ensure the ink storage temperature and humidity. 

 

1.6 Equipment Installation Precautions 

GCC JV-240UV shall be installed in a relatively clean, free from dust environment and the surface 

for the equipment to be installed shall be stable and flat. We suggest that you install the 

equipment in an air-conditioned environment to control the appropriate temperature and 

humidity. To ensure the equipment and the materials reach to the room temperature 24 hours 

prior in operation. For the environment shall meet following conditions: 

WARNING 

Prohibit on exposure under 

direct sun light 

Prohibit on setting up on tilt 

surface 
Temperature and humidity 

Skin Protection 

Avoid skin contact by wearing safety gloves.  Clean protective equipment 

regularly.  Then, wash hands and other exposed areas with soap and 

water before eating, drinking.  When leaving work, drink a lot of water. 

Eye Protection 

Wear safety glasses with side shields when handling ink to avoid the 

possibility of eye contact by slashing or spraying liquid.  Do not wear 

contact lenses. 
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The operation environment 

for this 

equipment:  

22 to 30°C (71.6°F to 86°F) 

40% to 60% (humidity) 

 

 

 

Avoid locations with vibration 
Avoid locations with strong 

air current 
Avoid locations with flame 
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Chapter 2 Main body instruction 

JV-240UV spot varnish printer can be used in the materials of coated art paper, Curious Metallic 

Paper and rigid material, which is in line with your application/design of customized spot varnish 

printer. 

Note：It is recommended to use the paper more than 150lbs. 

Note：Applicable material size is 610mm x 380mm (24" × 15"). 

 

2.1 Spot varnish printer 

GCC JV-240UV spot varnish printer 

Innovative JV–240UV spot varnish printer inherits the characteristics of GCC high quality machine, 

which has high capacity, high quality, and stable performance, wherein the innovative vanishing 

technology and the collocation of color touch screen further increases operational convenience. 

In the market applications of GCC JV–240UV spot varnish printer, in addition to the advertisement, 

catalog, packaging printed matter, etc., the highlighted part needs to be implemented the local 

varnishing coating, and the glazing pattern compared with the surrounding one should show more 

bright and beautiful appearance and strong stereoscopic sensation, which can produce a unique 

artistic effect to meet your requirement in all sorts of use. 

 

 

2.1.1 Main features of spot varnish printer 
1. Maximum of 610x380mm (24 x15 in.) work area 

2. Media Thickness up to 11.8 in. / 300 mm      

3. CCD module for image scale and rotate and compensation 

4. Up to 15Kg material weight 

5. Up to 10 m2/hr print speed 

6. AMC™ Auto Media Calibration 

7. Touch control panel 

8. Dual LED for fast curing 

9. Motorized z-axis positioning table 
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2.1 JV-240UV Appearance 

2.1.1 JV-240UV Front View 

 

 

 
                

 

 

 

 

 

 

 

 

H. Touch screen 

control panel 

D. Alignment 

ruler 

F. Bulk Ink supply 

system E. Front door 

G. Emergency 

stop button 

K. Print head set 

L. CCD 

I. Waste ink 

bottle 

C. LED lamp 

A. Maintenance 

J. Printing area 

M. Toolbox 

 

 

 

B. Barometer 
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2.1.2 JV-240UV Rear view 

 

 

     

 

 

 

 

 

 

 

O. Fuse 

R. Ethernet 

Q. USB 

P. Power socket 

N. Rear door 

T. Side cover 

S. Power switch 
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2.1.3 JV-240UV Parts Description 

Parts Name Description 

A. Maintenance Maintain print head cleanness 

B. Barometer Ink pressure adjustment and display. 

C. LED Lamp LED Lamp for curing after printing 

D. Alignment Rulers Media can be aligned with the guide line marks 

E. Front Door Keep closed. Unless in necessary to open it up for loading the 

material. 

F. Bulk Ink supply 

system 

Where the bulk ink bottle are installed 

G. Emergency Stop 

Button 

Stop the machine under emergent condition. 

H. Touch Screen 

Control Panel 

Set and display JV-240UV printing settings. 

I. Waste Ink Bottle Waste ink area. When waste ink is full, please take down the 

waste ink bottle and dispose it. 

(Please follow the local regulations to dispose the waste ink to 

prevent contaminating the environment) 

J. Printing Area The area where JV-240UV conducts the inkjet printing. 

K. Print Head Set Printing graphic image 

L. CCD CCD.  

M. Toolbox Store commonly used tools. 

N. Rear Door Keep closed. Unless in necessary to open it up for loading the 

material.  

O. Fuse  3 Amp fuse to protect the circuits. 

P. Power Socket Hold the AC power cord. 

Q. Ethernet Provide network connection between JC-241UV and computer. 

R. USB USB connection. 

S. Power Switch Switch on / off the power supply 

T. Side Cover The side cover of JV-240UV 
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Chapter 3 Installation Procedure 

3.1 Machine Setup 

3.1.1 Turn On The Power 

Step 1 Please check the ink chip is inserted properly into the corresponding slot.  

 

 

Step 2 Pour the Varnish into a large ink bottle labeled with a V label 

 

 

Step 3 Please plug in the power socket and turn on the power switch 

Note: Please wait for 5 seconds to turn on/turn off the power if you need to restart the machine. 
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3.1.2 Set Ink Flow To Printer Heads 

Step 1 Remove the thumbscrew and open the left cover. 

  

Step 2 Open the ink valve. 

   

Ink valve is opened            Ink valve is closed 

 

Step 3  

2. Select MENU 

      3. Select MAINTENANCE 

      4. Select INK INSTALL/DRAIN 

       5. Select INK INSTALL FLOW 
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Step 4 Ink install flow: 

1.Empty waste ink bottle.
2.Open the ink valves of print Head.
ENTER                                   CANCEL

       Start Ink Install Procedure?

ENTER     CANCEL 

Open the ink valves of ink bottle as 
shown
ENTER                                   CANCEL

Insert the chips of each color. Do not 
insert the chip of flush solution
ENTER                                   CANCEL

Make sure the chips of each color are inserted 
properly and the chip of flush solution is removed
ENTER                                   CANCEL

Seal the bottle caps
ENTER                                   CANCEL

Check ink level…

(YMCK) low ink level
Fill (YMCK) ) into ink bottles
ENTER                                   

Ink pumping
ENTER                                   CANCEL

The process is complete
ENTER                                  

adequate ink
inadequate ink

 

Step 6 Close up the left cover and fix it with thumbscrews.  
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3.2 Install JV-240UV VLCD  

3.2.1 Install CCD driver  

Step 1 Insert JV-240UV installation disk, select JV-240UV-CcdLibrary.exe and perform installation 

 

 

Step 2 Select Next 

 

 

Step 3 Select installation path and then select Next 

 

 

Step 4 Select Next 
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Step 5 Complete the JV-240UV-Ccd installation 

 

 

3.2.2 Install PlugInInstall driver 
Step 1 Select CCDMarkPlugin.exe and perform installation 

 

 

Step 2 Select Install (The computer must have installed Corel Draw/Illustrator) 

 

 

Step 3 Select OK 

 

 

Step 4 Select OK 
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Step 5 Select OK, complete the CCDMarkPlugin installation 
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3.3 Set the IP Address of the spot varnish printer 

3.3.1 How to IP Address 

Note：Please confirm that Ethernet and USB cable have connected to your computer.  

Note：Please use the Ethernet cable provided by GCC. If you buy it by yourself, please purchase 

Cat 5e Ethernet cable or above.  

 

Step 1 Launch JV-240UV VLCD  

 

Step 2 Confirm the IP address of the machine, and select the touch panel of the spot varnish printer 

Step 3 

   1. Select MENU on the control panel. 

  2. Select NETWORK 

   3. Select IP 

Step 4 Enter IP, select the value on IP/Sub Mask/Gateway, confirm/change the IP location required, 

and select the return key  

Step 5 Start (VLCD) and Press Open option 

 

Step 6 In the IP Address field of (VLCD), input the same values as those in the IP ADDRESS of the 

touch panel, and click Save. 

 

 Step 7 Restart JV-240UV VLCD and the setting is complete. 
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3.4 How to calibrate CCD Mark detection 

Step 1 Place the material printed with Mark dot on the origin of the XY coordinates of the spot 

varnish printer  

 

 

Step 2 Select Move To Mark, JV-240UV spot varnish printer will start CCD automatically and move to 

Mark point 
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Step 3 At Learn ROI in CCD window, move the square frame to the average of the black Mark, and 

select Learn Mark 

Note：In CCD window, user can fine tune the Learn ROI through arrow keys 

Note：CCD brightness control can be implemented through Light Level pull-down menu, after the 

completion of the adjustment, press Set to confirm 

 

Step 4 Select Move To Home 

 

Step 5 Select Save Mark 

Note：Learn Save Mark for the first time, it is recommended to save the file, and then read it 

directly from Load Mark 

Note：The surface of the material on the market is different, and it is recommended to relearn 

Mark 
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Chapter 4 Control Panel 

This section mainly describes JV-240UV Varnish Printer’s touch screen control panel, work flows 

and key operations.  

 

4.1 Control Panel Workflow 

Operating work flow: 
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Operating work flow: 
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Control panel flow: 

 

 

 

 

 

 

USER SET 

 

AUTO CLEANING 

 

MANUL CLEANING 

 

POWER SAVE 

 

VACUUM 

 

INK REMAINIING 

 

MAINTENANCE 

 

SYSTEM INFO 

 

OPTION 

 

NETWORK 

 

RESTORE 

 

DEFAULT 

 

SET1 

 

SET2 SET3 

 

PARAMETER： 

AMC 

VACUUM 

LED POWER 

 

MANUL CLEANIING：YES 

 

NORMAL 

 

POWERFUL 

 

X：_______ 

Y：_______ 

 

 

PURGE 

 

PH GAP AUTO DETECTION 

 

NOZZLE CHECK 

 

X 

 

Y 
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Operating work flow:  
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Control panel flow:  

 

 

 

 

 

O N 

FRONT： 

REAR： 

O N 

O N 

OFF 

OFF 
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Operating work flow: 

 

 

Control panel flow: 

 

 

IP：192.168.102.249 

Sub Mask：255.255.255.0 

Gateway：192.168.102.250 

MAC Address： 

00：CF：52：72：03：01 

RESTORE DEFAULT：YES 

ON OFF 
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PAUSE while printing: Users can pause on the printing job by pressing the PAUSE button and 

proceed to cleaning procedure to improve printing quality. 

Operating work flow: 

 

Control panel flow: 
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4.1 Control Panel Layout Description 

Control Panel Layout Description 

Function Description Setting  Default 

Media sizing 

 

VACUUM 

To hold the sheet media flat onto 
the work area by vacuum force; 
when the function is on, the 
vacuum will work when printing, 
while when it is off, the vacuum 
will not be carried out when 
printing. 

ON/OFF ON 

 

(LOAD MADIA) 

Set/Place media height 

  

 

(AMC) 

Automatically detect the media 

height 

  

 

(SmartPOSITION) 

Set printing area 

  

MENU→ USER SET 

 

USER DEFAULT/ 

SET1/SET2/SET3 

1) USER DEFAULT：Initial parameters 

settings 

2) SET1~3 parameter settings 

 (Adjust VACUUM/ BAND/AAS 

OFFSET/BI-UNI setting)  

Can store up to 3 

groups 

User DEFAULT 

MENU→  NOZZLE CHECK 
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NOZZLE CHECK 

Perform print head nozzles checking   

MENU→ CLEANING 

 

NORMAL 

Normal print head cleaning   

 

 

POWERFUL 

Powerful print head cleaning   

MENU→ MANUL CLEANING 

 

MANUL CLEANING 

When cleaning the print head 

manually, the cartridge will move to 

maintenance area on the left hand 

side automatically for cleaning. 

  

MENU→ POWER SAVE 

 

POWER SAVE 

Automatically switches off the display 

of control panel when the device 

hasn't been used for a set period of 

time, allowable setting are 15 sec., 30 

sec., 1 min., 3 min. and 5 min. 

 3 MIN. 
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MENU→ VACUUM 

 

VACUUM 

Vacuum function is to ensure 

material’s flatness. This setting can be 

enabled or disabled.  Default is 

enabled.  If choose disable, then 

there will be no vacuum sucking 

during the printing operation. 

 

ON/OFF OFF 

MENU→INK REMAINING 

 

INK REMAINING 

Check remaining ink volume 

* 99 means there is sufficient ink 

* 0 means short of ink, need to refill 

ink immediately. 

  

MENU→ MAINTENANCE 

 

REPLACE LED LAMP 

Automatically move the cartridge to 

the maintenance area on the left hand 

side for LED lamp replacement. 

YES YES 

 

REPLACE WASTE INK 

BOTTLE 

Replace waste ink bottle YES YES 

 

INK INSTALL/DRAIN Ink-install flow 
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Ink-drain flow 

MENU→ SYSTEM INFO 

 

SYSTEM INFO 

MODEL：Display the equipment 

dimension and model based on 

factory version settings 

FW：Display Firmware version serial 

number based on factory version 

settings. 

FPGA：Display FPGA version serial 

number based on factory version 

settings. 

INK ID FPGA：Display Ink ID FPGA 

version serial number based on 

factory version settings. 

ENGINE FPGA：Display ENGINE FPGA 

version serial number based on 

factory version settings. 

 

  

MENU→ OPTION 

INCH User can choose between Metric or 

Imperial measurement. 

Metric (cm, g) 

Imperial unit (inches, 

oz) 

Metric (cm, g) 

LANGUAGE SET LCM display language   

MENU→ NETWORK 
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IP ADDRESS 

IP address   

 

MCA ADDRESS 

MAC address   

MENU→ RFACTORY DEFAULT 

 

FACTORY DEFAULT 

Reset machine setting to factory 

default. 

 YES 

MENU→ PH GAP AUTO DETECTION 

 
PH GAP AUTO 

DETECTION 

Automatically detect the gap between 

print head and media. 

 ON 

MENU→ TIME LOCKER 

 

TIME LOCKER 

Set the period of time that the 

machine can be operated. The Time 

Locker function can be used for hire of 

a machine to schools or organizations 

to manage the rent duration of a hired 

machine.  

 OPTIONAL 
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PAUSE while printing Description 

PRINT LED LAMP→ 

 

LED LAMP 

Set LED Lamp Curing energy while 

printing 

ON/OFF ON 

PRINT CANCEL JOB→ 

 

CANCEL JOB 

Delete current print job  ON 

PRINT PAUSED→ 

 

NORMAL CLEANING 

Normal print head cleaning  ON 

 

POWERFUL 

CLEANING 

Powerful print head cleaning  ON 

 

MANUL 

CLEANING 

When cleaning the print head 

manually, the cartridge will move to 

maintenance area on the left hand 

side automatically for cleaning. 

 ON 
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Chapter 5 Operating the JV-240UV 

5.1 Hardware Operation 

5.1.1 How to Set Flatbed Printing Mode 

NOTICE: 

The factory setting of the height between print media and print head is 3mm. 

If the height between print media and print head is more than 3mm, it may cause ink droplet 

misting or splashing and lead to a grainy and uneven printing.  

When the height between print media and print head is more than 3mm, the reflected light from 

UV curing lamp increases and it can cause the misting ink to be cured, increase the ink visocosity 

and nozzel clogging, and hence damage print heads.  

 

 

NOTICE: 

 It is suggested to use the lamilator with decurling device to keep the sheet flat. 
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5.1.2 How To Set PH Gap Auto Adjustment Mode 

The PH Gap Auto Adjustment mode: 

It is suggested to set the settings to be “ON” (the default setting). Turning on the PH Gap Auto 

Adjustment mode provides the fastest way for users to start printing on the media of which the 

surface may be not flat or even, and the definite highest position of the media for AMC cannot 

easily be found. Also, it protects print heads from being scratched by automatically adjusting the 

print heads to optimized position when obstacle is detected.  

When the setting of PH Gap Auto Adjustment Mode is “ON”: 

If there is obstacle being detected, three steps can be applied, 

1. Cancel job: cancel current job and redefine the highest position of the media for AMC to obtain 

the best printing quality.  

2. Continue to print by the mode set in FlexiPRINT: The print quality may be decreased, because 

the print head gap is not the optimum value. 

3. Continue to print by uni-direction: The throughput may be decreased and the quality may be 

slightly affected, because the print mode is forced to set to uni-direction and the print head 

gap is not the optimum value. 

Under the following conditions, the PH Gap Auto Adjustment Mode can be set to OFF for 

advanced users, 

1.  The media is flat or the highest position of the media for AMC is easily to be determined. 

2.  High print quality is high priority:  

The platen will not automatically be adjusted to optimized position and the print job will be 

canceled when obstacle is detected. The optimum print head gap defined by AMC is a critical 

element for printing quality especially when performing bi-direction printing. 

3.  High throughput is high priority:  

The laser beam scanning speed is faster when the setting is OFF than it is ON, and the default 

print mode (bi-direction) will not be changed for higher printing speed. 
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Workflow 

A. Set the “PH Gap Auto Adjustment” to be “ON” on control panel: (The default setting) 
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B. Set the “PH Gap Auto Adjustment” to be “OFF” on the control panel: 
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5.1.3 How To Print On Rigid Material 

When the setting of PH Gap Auto Adjustment mode is “OFF”, refer to the following two 

exsamples for the instructions of rigid material printing: 

Example 1: Set parameter settings of full table print size 

Please load the rigid material correctly according to following steps. 

Step 1.  Entre FLATBED mode. 

Step 2.  Select MENU. 

Step 3.  Select USER SET. 

Step 4.  Select DEFAULT and select BACK icon . 

 

Step 5. Place print media on the lower right corner of the platen of JV-240UV. 

        

 (CAUTION)  
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Step 6.  Select LOAD MADIA, and then adjust the height of platen of JF-240 to proper 

position.  

(Note: the printing side should always be adjusted BELOW the print head.) 

 

Step 7.  Select AMC to autamatically detect the height between print media and print 

head. 

(Note: It is suggested to apply AMC onto the highest position of the media.) 

 

Step 8 The computer sends the file, complete. 

 

Example 2: Set parameter settings of SmartPOSITION (define a diagonal as print size) 

Please load the rigid material correctly according to following steps. 

Step 1.  Entre FLATBED mode. 

Step 2.  Select MENU. 

Step 3.  Select USER SET. 

Step 4.  Select USER 1 and select BACK icon . 

(Note: Choose USER1/USER2/USER3 to save the settings of SmartPOSITION, so user can print on 

the same area without repeatedly setting) 
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Step 5. Place print media on platen of JV-240UV. 

    

Step 6.  Select LOAD MADIA, and then adjust the height of platen of JF-240 to proper 

position.  

(Note: the printing side should always be adjusted BELOW the print head.) 

 

Step 7.  Select AMC to autamatically detect the height between print media and print 

head. 

(Note: It is suggested to apply AMC onto the highest position of the media.) 

 

Step 8 The computer sends the file, complete 

 

Step 8.  Select SmartPOSITION. 

Step 9.  Press the Arrow Keys to move the 

cartridge to the lower right corner of the print material and then press Position 1 icon 

; then move cartridge again to the upper left corner of the print material and press 

Position 2 icon  

 

Step 10 The computer sends the file, complete 
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5.1.4 How to make a Varnish file 

Note：Varnish solution is to print a thin and uniform transparent layer on the surface of the 

printed matter, and then to be solidified by UV. The varnishing can protect the printing 

pattern and increase its scratch resistance. Different varnish modes provide different visual 

effects, not only offer high added value, but also save coating equipment and labor costs 

 

Illustrator example： 

Using Illustrator software to create varnish file, please refer to the steps below. 

Step 1 Create Varnish image 

(It is suggested to create the Varnish image in monochrome) 

   
 

Step 2 Select File→Scripts→JV-240UV_CCD_Mark 
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Step 3 Margin(10~50mm) setting：10mm, Size(3~10mm) setting：5mm 

 

 

 

Step 4 Complete the 4 Mark points and open the finished Varnish layer 

Note：Varnish layer is suggested to be filled with black 

  

 

Step 5 Select File→Export→Export As….. 
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Step 6 Save as Tiff file, set the settings in TIFF Options window then click OK. 

Color Model：Grayscale 

Resolution：Other、720ppi 

Anti-aliasing：None 

Check LZW Compression 

 

 

Step 7 Open JV-240UV VLCD and click Add job 

 

 

Step 8 Select the .tiff file that just created and click Open 
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Step 9 Right click on the file and click Job Properties 

 

Step 10 Select AAS Scan type: 4 Markers  

 

Step 11 Select print mode parameters → OK 
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Varnish settings: 

Ink Percentage: Level 1~Level 5 inked number of the ink 

Print Mode: 

Gloss: The graphic surface is coated with a bright finish  

Super glossy: Enhance the surface coating of the graphics 

Base Printing: Check Enable, for bottoming before printing, Level 1~Level 4 bottoming thickness of 

the ink 

Shape Pinning: It can improve some material printing Varnish easily overflowing, to effectively 

prevent the Varnish overflowing printing scope. 

 

 

Step 12 Select the file, and then select Send 

 

 

 

Step 13 Complete the setting of JV-240UV spot varnish printer and start printing 

 

 

 

 

CorelDraw Example： 

Step 1 Build Varnish images 
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Step 2 Select Tools→ Macro→ Run Macro…, select GlobalMacros (JV-240UV_CCD_Mark.gms), and 

then select→ Run 

 

 

 

Step 3 Thickness(5~10mm) setting：5mm, Margin(10~50mm) setting：10mm 

Explanation：Make By Object：Select the locating point at the edge of the object    



                                           JV-240UV User Manual 

49 

 

Make By Page：Select the locating point at the page 

 

 

Step 4 Complete the 4 Mark points and open the finished Varnish layer 

Note：Varnish layer is suggested to be filled with black 

  

 

Step 5 After the Varnish layer is opened, select File→Export→select Save as type：Tiff 

 
  

Step 6 Set Resolution in Convert to Bitmap window：720dpi, Color mode：Grayscale(8bit), select OK, 

and then complete 
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Step 7 Please refer to 5.1.4 “How to make the glazing printing file”, Step 8~13 How to build Add job 

in JV-240UV VLCD  

 

 

 

 

 

 

 

 

5.1.5 How To Create Custom Pattern for Varnish Printing 

Users are allowed to use graphic design software to create a preferred pattern and apply it for 

varnish printing to produce unique effect on the print media. Follow the steps to create a custom 

pattern for varnish printing. Microsoft Paint is used as an example here.  

1. Open Paint, go to File under Properties.  
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2. Select Pixels in Units column and set Width/Length value. The Width/Length value must be a 

multiple of 8, i.e. 8 x 8 or 160 x 160 pixels  

 

 

 

3. Create a desired pattern.  
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4. Save the file as .tiff format and .jpeg format.  

 

 

5. Save the .tiff file to the location C:\Program Files (x86)\FlexiPRINT 10.5.1 GCC 

Edition\Program\GCCJF240UV\TestPattern\Varnish\Mark 

 

6. Save the .jpeg file to the location C:\Program Files (x86)\FlexiPRINT 10.5.1 GCC  

Edition\Program\GCCJF240UV\TestPattern\Varnish\Preview 

 

7. The custom pattern for varnish printing is complete. 
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5.1.6 How To Make Varnish Grayscale 
Step 1 Open Photoshop 

 

 

Step 2 Create a new file and set the parameter. 

Note：Resolution 720dpi、Color Mode： Grayscale 

 

 

Step 3 Use Gradient Tool to fill the color  
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Step 4 Go to Image → Mode → Bitmap… 

 

 

Step 5 Set the Output: 720, Method: select Diffusion Dither, and then click ok. 

 

 

Step 6 Complete gradient grayscale  
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Step 7 Go to file → Save    

 

 

Step 8 Define the file name and select file type as TIFF and click Save. 

 

 

Step 9 The process is complete. 
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5.1.7 Simplified Output Procedure 

Basic Output Message 

Please make sure test tuning / printing / quality / LED lamp are ok. 

Note: The tuning setting confirmation prior machine printing is very important; please double 

check to ensure they are correct. 

  Print             

Check Nozzle  v 

Check Bi-directional v 

Check Color Offser v 

Check AMC v 

 

 

5.1.8 Reset Back To The Factory Settings 

If messed up the parameter settings in the above operation, user can select from the control panel, 

follow the steps to reset back to the factory default. 

 

Step 1.  

 1. Select MENU on the control panel. 

 2. Select RESTORE DEFAULT. 

 

Enter RESTORE DEFAULT, select YES option then press ENTER to complete the 

restore to factory default settings. 

Note: YES to restore the factory default settings. 
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5.1.9 Check Print Head Condition 

If the printing quality deteriorates during the process or daily operation, we recommend printing a 

print head test chart to make sure the print heads are defect or not.  If there is defect in the print 

heads, recommend cleaning up the print heads.  

 

Step 1 Perform NOZZLE CHECK 

  1. Select MENU on control panel 

 2. Select NOZZLE CHECK 

 3. Set X and Y coordinates of NOZZLE CHECK pattern on the 

material and select CONFIRM. 

 

Step 2. JV-240UV will execute Nozzle Check automatically to ensure the print head quality. 

 

 

If there is blocked pixel in print head, recommend to conduct following steps:  
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Step 3. Conduct normal cleaning (Suggest for first time cleaning). If the problem persisted, please 

repeat the cleaning process. 

  1. Select MENU on the control panel. 

   2. Select CLEANING  

   3. Select NORMAL and the machine will proceed to NORMAL Cleaning. 

Step 4. Conduct POWERFUL cleaning (when NORMAL cleaning does not clean throughout, it is 

suggested to conduct POWERFUL to clean up). 

  1. Select MENU on the control panel. 

 2. Select CLEANING. 

 3. Select POWERFUL and the machine will proceed to POWERFUL cleaning. 

Step 5. Conduct the printing test, to ensure the print head blocked problem has been solved. If the 

problem continues, please conduct the 2nd cleaning cycle. If the machine has been used for a long 

time, recommend to clean manually. 

 

5.1.10 How To Pause/Clean/Delete The Job While Printing 

When it is printing incorrectly or error occurs, it is suggested to use the PAUSE button on the 

control panel to stop printing. 
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Pause while printing: 

Step 1.  Select PASUE on the control panel. 

Step 2. To resume the job, press  PAUSE button on the control panel again to continue the 

job. 

Clean while printing: (when cleaning print heads is required while printing)  

Step1: Select  PAUSE button on the control panel.   

Step 2. LCM shows  

Step 3. Select NORMAL CLEANING, and press ENTER for NORMAL mode. 

Step 4. Select POWERFUL CLEANING, and press ENTER for POWERFUL mode. 

Step 5. Complete cleaning, select  RESUME to continue. 

Canceling job while printing 

Step1: Select  PAUSE button on the control panel. 

Step 2. Select CANCEL JOB on the control panel. 

Step 3. Press  ENTER again to cancel the job. 
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5.2 Tuning and Testing Procedure 

Note：When the buzzer sounds, please check the message displayed on the control panel and 

solve the problem. 

Note：When the machine does not function normally, please press the emergency stop switch and 

restart the spot varnish printer, and solve the problem 

 

5.2.1 Read machine parameter values 

Follow the steps below to read the parameters from the machine when operating the machine for 

the first time.  

 

Step 1 Start JV-240UV VLCD, press Open option and select “Parameters backup from machine”, and 

then JV-240UV VLCD will automatically read the parameters from the machine. 

Note：The detected parameter settings include Color Offset, Bi direction Offset, and PH 

Parameters, etc. 
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5.2.2 Introduction of JV-240UV VLCD 

 

 

GCC JV-240UV Spot varnish printer VLCD Introduction 

Job Properties 

 Quality Mode Production 

Quality 

Light Density 

Print Direction Uni directional: Uni directional printing mode 

Bi directional: Bi-directional printing mode 

AAS Scan Type None: No AAS detection before printing  

4 Markers: Read 4 AAS marks before printing 

Image Position(X,Y mm) Image XY coordinates setting (Default value is 

0,0) 

Image scale(X/Y) Adjust the image scale of media length and 

width 

Media type Save settings：Save the parameters 

Delete media： Delete the parameter 

Print origin offset 

(X/Y) 

Set a new origin 

Paper Feeder enable  

Paper height(mm) Media length 

Paper feeder repeat Copies 
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count 

 

Print Varnish 

 OPEN Activate the spot varnish printer connection 

CLOSE Deactivate the spot varnish printer connection 

IP ADDRESS IP address 

SAVE Store the IP address  

Add job Add job menu 

Send Send job menu 

Stop Stop job menu 

Light Level Adjust the LED brightness 

Mark Position(X,Y) X/Y location 

CCD Calibration CCD calibration 

Load Mark Read AAS mark  

Save Mark Store AAS mark 

Move To Mark Move CCD to read the AAS marks for 
calibration 

 Learn Mark Learn AAS mark 

Move To Home Move the carriage back to the origin 

Print Settings 

Set the print menu 

 Color to print Ink-jet number 

UV lamp curing mode Normal Curing: Regular curing mode  

Delay Curing:  Delay curing mode  

UV Power UV light energy 

Enable job repeat function Enable repeat function 

Enhance UV Curing Preform curing automatically after 
printing 

Save Store the parameters under Print Settings 

menu 

Color Offset 

Set the print direction  

 Pattern Nozzle Check(Check the nozzle condition) 
Head Angle(Check the vertical angle of 
the nozzle) 
Color Offset(Check the one way quality of 
the nozzle) 
Bidirection Offset(Check the two way 
quality of the nozzle) 
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Over Print：a number of layers will be 

printed 

Color Offset 

 

The parameter adjustment of the inkjet 
head one way alignment correction, to 
select one way is to print the image from 
right to left, so as to confirm the accuracy 
of one-way set. 

Bidirection Offset 

 

The parameter adjustment of the inkjet 
head two way alignment correction, to 
select two way is to print the image from 
right to left and return back, so as to 
confirm the accuracy of two-way set. 

Start ZeroPoint X coordinates initial position 

Print Head To Edge Distance Y coordinates initial position 

Print Scale Image scale 

Read Read 

Save Save 

Paper Feeder Y Position Calibration 

 Offset(mm) Calibrate the position of paper feeding 

Paper Height(mm) Calibrate the media length 

Feeder Paper Paper feeding test 

Take Paper Paper ejecting test 

Adjust Vacuum Position Feeder arm stretch (Adjust the suction 

cup position) 

Adjust Vacuum Back Feeder arm withdrawal 

Job ink use 

Job ink consumption 

 V 0.0000CC Ink usage 

Read Read the previous ink usage 

PH PARAMETERS 

Adjust the parameters of inkjet head parameters 

 Read  Read the inkjet head parameters 

Write Write the inkjet head parameters 

Channel V1, V2, V3 and V4 inkjet heads color 
names 

Drop/Speed m/s Adjust the spray speed of the inkjet head 

Default Voltage Adjust the voltage of the inkjet head 

MACHINE PARAMETERS  

 Write Parameters to 
machine 

Write parameters to the machine end 

Parameters backup from Read the backup parameter values from 
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machine the machine 

Data Bridge FW Update 

 Boot to Loader Boot to Loader 

Boot to Firmware Boot to Firmware 

Add Firmware Add Firmware 

Update  Update  

Add Test Pattern Add Test Pattern 

Update Update 

 

5.2.3 Preliminary Calibration Parameters 

Set the printing direction. When Uni-Directional is selected, the image will be printed only from 

right to the left; when Bi-directional is selected, the image will first printed from right to left, then 

from left to right. This calibration is primarily used to ensure the uni-directional / bi-directional 

printing precision. 

 

Uni-Directional Calibration:  

1. Start JV-240UV VLCD, select Color Offset→Color Offset and press Print 

 

 

2. JV-240UV will automatically start Color Offset Test Pattern printing 

 

Following are horizontal alignment calibration examples:   

3. Use black to correct other colors. 

4. A total of 32 correction lines will be displayed on the horizontal calibration pattern, and the 

numbers are showed from left to right with the 16th line (0) showing the initial number.  

5. These figures will show the error values caused by the spots of various inkjet heads. 

 

Example 1: The horizontal correction of V2, V3, and V4 inkjet heads. 
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Step 1  Use a magnifying glass to observe that the V2 color and black lines are aligned to the "-3" 

line. Please record this number.  

Step 2  Use a magnifying glass to observe that the V3 color and black lines are aligned to the "+5" 

line. Please record this number. 

Step 3  Use a magnifying glass to observe that the V4 color and black lines are aligned to the "-3" 

line. Please record this number. 

Step 4 After recording all the Numbers, please go to the Color Offset "V2, V3, V4" under the 

control interface of (VLCD) software to perform the horizontal fine tuning. 

    
Example：V2=120-3=117 (VLCD) input 117 

V3=203+5=208 (VLCD) input 208 

V4=282-3=279 (VLCD) input 279 

Step 5 Enter all inkjet heads that need to be corrected and then store to update the settings. 
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Bi-Directional Calibration:  

1. Start JV-240UV VLCD, select Color Offset→Bidirectional offset and press Print 

 

 

 

2. JV-240UV will automatically start Color Offset Test Pattern printing 

 

3. Select Color Offset Offset→ Bidirectional offset option 
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Following are horizontal alignment calibration examples:   

4. Use black to correct other colors. 

5. A total of 32 correction lines will be displayed on the horizontal calibration pattern, and the 

numbers are showed from left to right with the 16th line (0) showing the initial number.  

6. These figures will show the error values caused by the spots of various inkjet heads. 

 

Example 1: The horizontal correction of V1, V2, V3, and V4 inkjet heads. 
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Step 1  Use a magnifying glass to observe that the V1 color and black lines are aligned to the "-3" 

line. Please record this number. 

Step 2  Use a magnifying glass to observe that the V2 color and black lines are aligned to the "+5" 

line. Please record this number. 

Step 3  Use a magnifying glass to observe that the V3 color and black lines are aligned to the "-3" 

line. Please record this number. 

Step 4  Use a magnifying glass to observe that the V4 color and black lines are aligned to the "-3" 

line. Please record this number. 

Step 5 After recording all the Numbers, please go to the Bidirectional Offset "V1, V2, V3, V4" 

under the control interface of (VLCD) software to perform the horizontal fine tuning. 

    

 

Example：V1=12-3=9 (VLCD) input 9 

V2=10+5=15 (VLCD) input 15 

V3=13-3=10 (VLCD) input 10 

V4=15-3=12 (VLCD) input 12 

 

Step 6  Enter all inkjet heads that need to be corrected and then store to update the settings. 
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Chapter 6 Maintenance And Basic Service 

This chapter provides the basic maintenance information for the JV-240UV Varnish printer (i.e. clean 

up operations for the flatbed printer). Other than the operations described here, the rest of the 

service must be carried out by trained maintenance professionals. 

To keep the flatbed printer in the best performance and the best printing quality, it is necessary to 

periodically clean / maintain this equipment with appropriate procedures. 

6.1 Check Remaining Ink and Refill Ink 

6.1.1 Check Remaining Ink 

 1. Select MENU on the control panel. 

 2. Select INK REMAININNG  

 3. Check remaining ink 

                        

 

Description: 

*Green light indicates high ink level. 

* Yellow light indicates medium ink level. 

* Red light indicates low ink level, ink should be refilled immediately. 
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6.1.2 How To Replace Bulk Ink 
When the Ink runs out, the touch panel appears the indicate “Ink run out”. Please immediately 

pour in a new ink. 

(Make sure that the ink bottle is marked in the same color as the poured ink before pouring in) 

  

 

Note : Be caution when replace the ink bottle: 

1) Please install the ink bottle to the position according to the color label. 

2) Please fill the ink slowly to prevent the ink from overflowing. 

3) Must be replaced with ink bottle of the same type. 

4) Do not use the uncertified ink bottle. 

5) Do not pull out the ink bottle while the equipment is printing. 

6) Please do not remove the empty ink bottle until a new one is inserted 

 

Warning: Do not store ink, flush cleaning solutions or liquid drained out at any following 

locations. 

Area might be exposed to flame, to avoid fire hazard.   

Area might be exposed to high temperature. 

Area exposed to bleach, any oxidant or explosive materials. 

Area might be reached by children to prevent health hazard. 
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6.2 Daily / Weekly / Monthly Maintenance 

6.2.1 Ink Print Head Cleaning 

  

Required daily cleaning:  

Check whether the print head in good condition. It is required to use sponge swabs with Cleaner 

(26501007G) to clean print head and print head area everyday. 

Note：Switch the ink valve off while cleaning, and switch the ink valves on after the process is 

complete. 

Print Head Cleaning  

 1. Select MENU on the control panel 

2. Select MANUL CLEANING  

 3. Select ENTER, press PURGE button and wait for 20 seconds, then press  

4. Remove thumbscrews and open the left cover and close ink valve.  

  

Thumbscrew 

Cover 
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5. Use sponge swabs with cleaner to clean the area underneath the print heads, and wipe residues 

from back to front. 

Note: Do not reuse the sponge swabs.  

Note: The change of color of sponge swab does not affect its function. 

 

6. Open ink valve, close up the left cover and fix it with thumbscrews, and press  

  

 

Required weekly maintenance:  

Check whether the print head is in good condition. It is required to use sponge swabs with Cleaner 

(26501007G) to clean print head and print head area every week, and make sure that ink bottle is 

not empty and dispose waste ink bottle. 

 

6.2.2 How To Turn On/Off POWER SAVE Function 

  

The function of POWER SAVE is to save energy. When the device idles longer than a set period of 

time, JV-240UV will automatically enter POWER SAVE mode. 

Select POWER SAVE on the control panel to activate POWER SAVE and press it again to deactivate it. 

There are five time interval setting, 15 sec., 30 sec., 1 min., 3 min. and 5 min, user may choose 

whichever is suitable.  

 

Thumbscrew 

Cover 
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6.2.3 How To Dispose Waste Ink Bottle  

When the waste ink bottle is full, control panel will display “Waste ink bottle is full” message. It is 

recommended that remove the waste ink bottle and dispose the waste ink to a waste ink collecting 

area. 

Dispose the waste ink according to the following steps: 

 1. Select MENU on control panel 

 2. Select MAINTENANCE  

3. Select REPLACE WASTE INK BOTTLE 

4. Remove the waste ink bottle 

     

 

5. Install the empty waste ink bottle 

 

NOTE:  

Waste ink bottle contains hazardous substances. Please DO NOT dispose the waste ink bottle with 

general garbage or discard it into sewage treatment system.   

Please follow the local regulations to dispose the waste ink to prevent contaminating the 

environment.  
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6.2.4 Cleaning 

Warning: Do not use gasoline, alcohol, or solvent … etc. flammable materials, as they are abrasive 

and hazardous, and could damage the equipment. 

Note: Please make sure power and ink valve are turned off and JV-240UV is done the printing job 

before cleaning process starts. 

Press the clip of ink valve to switch the ink valve off. 

      

Ink valve is opened      Ink valve is closed 

     

Note: When the machine is in printing, the moving parts might cause injury or high temperature 

components might cause burns.  

While in cleaning up process, please clean up ink residue or printing media on the platform 

and other area to avoid deposition. Use cloth moistened with diluted mild cleaning solution or 

water to wipe it out. 
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6.3 Print Head Maintenance And Clean Up 

Print head maintenance and clean up are important to ensure machine printing quality. Generally it 

can be divided into daily maintenance and periodically maintenance. 

Required daily maintenance: Apply automatic basic cleaning up maintenance. 

Required weekly maintenance: Apply automatic advanced cleaning up maintenance. 

Required monthly maintenance: Apply automatic advanced cleaning up maintenance, and wipe the 

print head with cleaning swabs. 

 

Note: When the machine idle 2~3day and the print head nozzle clog, please click Powerful Clean 

to flush it (each Powerful Clean process will take 8 min to complete the cycle). 

Note: When the machine is power-down longer than 7 days, please fill flushing solution into print 

head and drain the ink out, leaving the flushing solution in print head only. 

 

6.3.1 Maintenance And Clean Up 
Step 1 Remove thumbscrews and open up the right cover. 

  

 

Step 2 Remove the tool carriage cover. 

       

 

 

 

 

 

Thumbscrew 

Cover  
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Step3 Press the clip of ink valve to close it and turn off the machine. 

         

Step4 Switch on the ink tube  

       

 

Step5 Take in cleaner (26501007G) in syringe. 
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Step6 Inject cleaner (26501007G) into ink tube of print head 

       

 

Step 7 Switch off the ink tube 

       

 

Step 8 Close the tool carriage cover.  

       

  

Step 9 Complete 
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6.3.2 Automatic Basic Cleaning Up Maintenance 

For the daily cleaning up and maintenance, if the print head is clogged, it is recommended to apply 

basic cleaning up instruction procedure to clean up print head prior the print job. 

 

Step 1 Perform NOZZLE CHECK 

 1. Select MENU on the control panel 

2. Select NOZZLE CHECK 

3. Enter X, Y value and press ENTER 

  

 

Step 2 JV-240UV will print out Nozzle Check test pattern, if the printing quality is similar to the 

figure below, please clean it up according to the following steps. 

 

Step 3 
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 1. Select MENU on the control panel 

2. Select CLEANING  

3. Select NORMAL, and the machine will carry out automatic basic cleaning up procedure. 

  

Step 4 Repeat step 1~2 to confirm whether the basic cleaning can meet the required printing quality. 

If blocked area are filled, then the basic clean up is completed. 

   

 

 

6.3.4 Automatic Advanced Cleaning Up Maintenance 

For the periodically cleaning up and maintenance, if there is serious blockage in the print head, it is 

recommended to apply advanced cleaning up instruction procedure to clean up print head prior the 

print job.  

  

Step 1 Perform NOZZLE CHECK 

 1. Select MENU on the control panel 

2. Select NOZZLE CHECK 
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3. Enter X, Y value and press ENTER 

 

 

Step 2 JV-240UV will print out Nozzle Check test pattern, if the printing quality is similar to the 

figure below, please clean it up according to the following steps. 

 

 

 

Step 3 

 1. Select MENU on the control panel 

 2. Select CLEANING 

 3. Select POWERFUL, and JV-240UV will carry out automatic advanced cleaning up 

procedure. 
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4. Reconfirm whether the advanced cleaning can meet the required printing quality. 

          

Step 4 Repeat step 1~2 to confirm whether the advanced cleaning can meet the required printing 

quality. If the blocked area is filled, then the advanced cleaning is completed. 

 

 

 

6.3.4 Manual Maintenance 

Manually clean up the print head, based on your usage frequency, conduct manual clean up 

periodically. 

Note: Some reminders for manual clean up procedures: 

1)  Before the manual clean up, please remove any media on the JV-240UV printing platform. 

2)  Don’t use any tool other than the cleaning swab, as it might damage the print head.   

3)  Don’t use the cleaning solution which used to soak the print head or cleaning solution which 

already has been used to clean up the print head.  It could lower the cleaning efficiency. 

4)  For the manual cleaning, please move very slowly and use the minimal force, don’t rub, wipe, 

scratch, or crash the print head.  

* If the print head is damaged, please replace with a new one to ensure printing quality. For the 

wiper purchasing, please contact the GCC authorized distributors. 

Step 1 Use cloth to clean up the area with ink residue 

  

Step 2 
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 1. Select MENU 

2. Select MANUL CLEANING  

 3. Select ENTER (The cartridge will move to maintenance area on the left side) 

Step 3 Remove thumbscrews and open up the left cover 

   

Step 4 Press Purge switch for 3 seconds and wait for 20 seconds, then press  and close ink 

valve.  

 

Step 5 Dip the cleaning swab into the cleaning solution bottle to moisten it. 

                

Step 6 Check carefully if there are any residues of ink left on the area underneath the print heads.  

Thumbscrew 

Cover 

Be sure to clean using 

One of the included 

Cleaning sticks. 
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Step 7 Use sponge swabs to clean the area and wipe residues from back to front.  

 

Step 8 Open ink valve, close up the left cover and fix it with thumbscrews and select . 

 
 

 

 

6.4 How To Replace The Filter Of LED Lamp 

Note: It is suggested to change the filter of LED lamp every six months. 

Step 1 

 1. Select MENU on the control panel 

  2. Select MAINTENANCE 

 3. Select REPLACE LED LAMP. 

 

Thumbscrew 

Cover  
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Step 2 Remove the thumbscrews and open the right cover. 

  

 

Step 2 Turn off all ink valves. 

 

Step 3 Turn off the power and unplug the power cord. 

 

 

Step 4 Disconnect the Led Lamp wire.  

  

 

 

 

 

Screw 

Cover 



                                           JV-240UV User Manual 

86 

 

Step 5 Take apart the screw at the upper position which is connected with Led lamp set. 

 
 

Step 6 Take apart the screws at the side position which is connected with Led lamp set. 

 
 

Step 7 Take apart the screws (2 pieces). 
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Step 8 Replace a new led lamp filter and fasten the screws. 

 

 

Step 9 Follow the procedures in reverse order from step 8 to step 5 to assemble the Led lamp. 

 

Step 10 Plug in the power cord and restart JV-240UV. The process is done. 

 

 

 

6.5 Ink Drain Away 

Step 1 Remove thumbscrews and open the left cover. 

  

 

 

 

Thumbscrew

s 

Cover 
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Step 2 Turn on all ink valves. 

 
 

Step 3  

 1 Select MENU 

  2 Select MAINTENANC 

 3 Select INK INSTALL/DRAIN 

4 Select INK DRAIN AWAY 

 

Step 4 Fill flush into flush channel by order of the instruction on control panel to complete the 

workflow of ink drain. 

 

 

Step 5 Ink drain flow: 
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1.Empty waste ink bottle.
2.Open the ink valves of print Head.
ENTER                                   CANCEL

       Start Ink Drain Procedure?

ENTER     CANCEL 

Close the ink valves of ink bottle as 
shown
ENTER                                   CANCEL

Ink purging…

1.Empty the waste ink bottle
2.Open the ink valves of print head
ENTER                                   CANCEL

Flush purging
ENTER                                   CANCEL

Check Flush solution level…

Low flush solution level.
Fill flush solution into flush ink bottle.

1.Use cotton swabs with Cleaner to     
    clean print head and print head area.
2.Empty the waste ink bottle.
ENTER                                   CANCEL

The process is complete
ENTER                                   

adequate ink
inadequate ink

1.Insert the chip of flush solution.
2.Seal the bottle caps.
ENTER                                   CANCEL

 

 

Step 6 Assemble the left cover with thumbscrew. The process is complete. 

  

 

 

 

Thumbscrew 

Cover  
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6.6 Reset Pressure Gauge with Atmospheric Pressure  

Manually adjust the barometer underneath the machine on the left side to reset the pressure gauge 
with atmospheric pressure. 

Step 1 Close all tube clip above print heads 

  

 

Step 2 Open the right side cover (above main ink tank bottles) 

 
 

Step 3 Remove the plugs at the bottom of air pressure buffer tank, as soon as removed the plug, the 
pump will keep pumping. 

    (Figure 6-72) 



                                           JV-240UV User Manual 

91 

 

Step 4 Open the cover of pressure gauge. 

 

 

Step 5 Pressand buttons at the same and hold for 2 seconds. Release after “0Rd” is shown on 

the display and adjust the pressure gauge with andbuttons. 

    

Note: the default setting for pressure gauge is between 3~4 kpa according to local environment. 

Adjust the pressure gauge to optimized value base on the weather condition to prevent ink from 

dripping.  

Step 6 Put back the plug of air buffer tube. 

 

Step 7 Install back the gauge cover and right side cover. 

Step 8 Open the ink tube clip and complete the procedure. 
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6.7 Lubrication of the X Rails  

The procedure of Lubrication: 

Step 1 Power off the machine 

Step 2 Move the carriage rightwards or leftwards to allow the grease being injected. 

Step 3 Inject 10ml of grease to the injection opening inside the linear bearing on both side. 

Note: Lubrication regularly depending on the job loading, recommend on a quarterly basis. 

 
Lubrication Notes 

1. Slides and rails must be lubricated before use for the first time and avoid contact with any 

liquid or solid contaminants. 

2. The carriage must move back and forth on one side, while injecting the grease. 

3. Users can apply manual lubrication or automatic lubrication to the Miniature linear rail for 

regular maintenance. 

4. There should always be lubricant coated on the surface of the rail. 

5. Apply the lubrication again before the oil changes color due to corrosion. 

Lubrication Intervals 

1. The length of lubrication interval depends on the working environment, loading and pressure 

bearing condition. The length of the lubrication interval varies, and the safe lubrication 

intervals can only be known after careful observation. 

2. Lubrication interval should not exceed one year. 
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6.8 How to replace alignment rule 

Step 1 Use cross screwdriver to remove the screws on the alignment rules on X and Y axis. Replace  

      the thin alignment rule by the thick one and fix it. 

 

 

Step 2 The replacement of the alignment rules is complete. 
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Chapter 7 Reference Parameter Settings 

The following reference parameter is used on GCC verified materials. 

GCC JV-240UV material parameter table 

NO Material Print Mode Print Color Directional 
LED  

Power 
 

1 Chrome paper Production mode V Bi-Directional 100%  

2 Matt finish paper Production mode V Bi-Directional 100%  

3 Metallic finish paper Production mode V Bi-Directional 100%  
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Appendix A: JV-240UV Specification 

 

Model JV-240UV 

Printing method On-demand Piezo head 

Printing area (W x L) 24 x 15 in. (609 x 380 mm) 

Max. media size 

(W x L x H) 

Sheet 24 x 15 in. (609 x 380 mm) 

Thickness 

Flatbed mode: 11.8 in. (300mm)(standard)/ 6.7in. 

(170mm)(blower version)With auto feeder: 0.79in. 

(20mm) 

Weight Less than 15 kg in flatbed mode 

Media Type Acrylic, plastic, laminated, coated substrates, etc. 

Print head adjustment Auto Media Calibration (AMC™) 

Mark detection CCD module 

Print Speed 45 B3 sheet / hr(1) 

Varnish Thickness 0.04 mm to 0.32 mm(2) 

Print accuracy +/- 0.4mm 

Ink cartridges 

Type UV curable ink 

Capacity 1 Liter 

Colors Varnish 

Ink curing unit UV LED Lamp 

Control Panel Touch Screen (480 x 272 resolution) 

Interface Ethernet 

Distance Accuracy – When printing 
Error of less than +-0.3% of distance traveled,  

or+-0.3mm (0.01 inch), whichever is greater 

Voltage requirement 115/220VAC  50/60HZ 

Power consumption-Operating 
115V AC (60HZ) (Max. 270W) 

220V AC (50HZ) (Max. 260W) 

Power consumption-Stand by 
115V AC (60HZ) (Max. 160W ) 

220V AC (50HZ) (Max. 200W ) 

Environment (Temperature/Humidity) 22℃-30 ℃ (71.6℉- 86 ℉) / (40%-60% humidity) 

Dimension (W x L x H) Net 1,760 x 1,160 x 1,140 mm 
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69.3 x 46.7 x 44.9 in. 

Gross 
2,000 x 1,3000 x 1,360 mm 

78.7 x 51.2 x 53.5 in. 

Weight Net 262 kg 

 Gross 366 kg 

Optional Auto feeder, anti-static bar 

(1)
 Based on 4 print heads with draft mode. Higher varnish thickness will reduce print speed. Media load time is not 

included. 

(2)
 JV-240UV can achieve up to 320 microns in one print job with GCC recommended media. Repeat the same print 

job can accumulate the varnish thickness to higher level. 

 

 

*Please visit GCC club for the latest user manual download. GCC reserve the right to modify the user manual without 

notice. 


